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Question: 1 
What are some of the data-related challenges that create difficulties in making business 
decisions? Choose three. 
 
A. Too much irrelevant data for the job role 
B. A static reporting tool 
C. A business analytics tool that is too easy to master 
D. A reporting tool that allows the users to initiate their own query 
E. Ever increasing data volume 
 
Answer: A, B, E 
 
Question: 2 
S_ASSET is a primary table and S_ASSET_WRNTY is a child table of S_ASSET. An auxiliary 
change capture process would consider rows from S_ASSET table changed 
when_______________________________. 
 
A. rows in the S_ASSET table are actually changed 
B. related rows in the S_ASSET WRTY table are changed 
C. a script sends a text message indicating that the S_ASSET table should be changed 
D. the S_ASSET_WRTY table is flagged for changes 
 
Answer: B 
 
Question: 3 
What type of index improves query performance because both index and data segments are 
retrieved in one read? 
 
A. Clustered index 
B. B-Tree index 
C. Bitmap index 
D. JPEG index 
 
Answer: A 
 
Question: 4 
Which of the following are the most important reasons why you would run Exception Reports? 
Choose two. 
 
A. To increase ETL performance 
B. To improve ETL mapping accuracy 
C. To avoid running too many incremental ETL runs 
D. To check the data integrity of the Siebel transactional database 
E. To skip unnecessary DAC task phases 
 
Answer: A, D 
 
Question: 5 
What are the advantages of using a data warehouse to analyze data for business intelligence? 
Choose two. 
 
A. Data in a data warehouse is normalized 
B. There are fewer joins between data warehouse tables 
C. A data warehouse can bring data from multiple sources 
D. A data warehouse is best suited for entering, modifying, and deleting transactional data 
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E. A data warehouse is best suited for time-critical data for real-time update, such as to customer 
data 

 
Answer: B, C 
 
Question: 6 
Which is true of creating indexes? 
 
A. Staging tables typically do not require indexes 
B. Put filter conditions on all columns that ETL uses for dimensions and facts 
C. Defining indexes always slows down query performance 
D. DAC server can drop and then recreate query indexes if the DAC System Property 

DropAndCreateIndexes is set to False 
 
Answer: A 
 
Question: 7 
In which of the following DAC views would you specify the database owner and database user 
properties to an OLTP database? 
 
A. Design 
B. Monitor 
C. Execute 
D. Setup 
 
Answer: D 
 
Question: 8 
Exhibit: 
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Which of the following are true of the Exhibit? Choose two. 
 
A. It is one of the views of the Siebel Call Center application 
B. It is used to find out which column of the warehouse table S_OPTY contains the fields of the 

Opportunity business component 
C. It is accessed through View > Visualize > View Details in Siebel Tools 
D. Name is the name of the field; NAME is the name of the column 
 
Answer: C, D 
 
Question: 9 
Which are true of the DAC objects? Choose three. 
 
A. Table objects are the logical tables defined in the database schema 
B. A subject area is the logical grouping of the table groups related to a particular subject or 

application context 
C. A dependency rule determines the order in which tasks are executed 
D. Jobs are unique steps executed during the ETL and are related to data transformation or 

database objects 
E. The DAC objects can be found in the Design View's top-pane tabs 
 
Answer: B, C, E 
 
Question: 10 
Which statements about change capture views are TRUE? Choose two.  
 
A. They do not exist in the Siebel transactional database. 
B. They are dropped and created automatically when DAC performs a full or incremental load of 

the data warehouse. 
C. They are used to extract the relevant data from the Siebel transactional database. 
D. They cannot be generated manually. 
 
Answer: B, C 
 
Question: 11 
Which are true of the ? Choose two. 
 
A. It is the DAC Server Monitor Icon 
B. It shows that the DAC Server is disconnected 
C. It shows that Informatica Server is running 
D. It shows that the DAC Client is running an ETL process 
E. It shows that the DAC Client is connected to the DAC Server but the server is idle 
 
Answer: A, E 
 
Question: 12 
Exhibit: 
 



Exam Name: Siebel 7.7 Analytics Data Warehouse Developer Professional Core Exam 
Exam Type Oracle    
Exam Code: 1Z0-640 Total Questions: 99 
 

Page 4 of 26   

 

 
 
How would you find the table column that maps to the Status field of the Project list applet shown 
here? Choose two. 
 
A. Right-click the Status column heading to see the table column in the Siebel application 
B. In the Siebel application, select Help > About View from the application-level menu to find out 

which business component this applet is based on 
C. In Siebel Tools, select the Project business component > Field, then find the column property 

of the Status field 
D. In Siebel Tools, select the Project table and then find the column property of the Status field 
 
Answer: B, C 
 
Question: 13 
Which of the following is NOT a way to start the DAC server? 
 
A. By setting up the command line access to the DAC server 
B. By double-clicking the DAC Server icon on your desktop to run the startserver.bat file 
C. By setting up the DAC server as a scheduled task 
D. By double-clicking the DAC Client icon on your desktop to run the startclient.bat file 
 
Answer: D 
 
Question: 14 
Which of the following is one of the leading practices recommended by Siebel Systems when 
customizing Siebel Relationship Management Warehouse?  
 
A. Use custom mapping templates and modify them rather than creating them from scratch 
B. Do not edit source tables in Informatics Designer if source tables are extended after being 

copied into the Custom folder 
C. Run ETL process separately with the Siebel OLTP and external data sources 
D. Refrain from using Custom Mapping Templates but use those in the SDE and SIL folders 
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Answer: A 
 
Question: 15 
Name the method that starts an execution plan. 
 
A. StopETL 
B. ETLStatus 
C. StartETL 
D. InformaticaStatus 
 
Answer: C 
 
Question: 16 
Which does NOT affect the ETL query performance? 
 
A. Informatica Server throughput 
B. Siebel OLTP schema 
C. Database server throughput 
D. Data volume 
 
Answer: B 
 
Question: 17 
How would you solve the deadlocked repository? 
 
A. Restart the execution plan 
B. Check the log and fix the problem 
C. Use Informatica Repository Manager to release all locks 
D. Use DAC client to release all locks on Informatica repository 
 
Answer: C 
 
Question: 18 
Using the exhibit: 
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Identify the Delete Image table? 
 
A. S_ETL_R_IMG_87 
B. S_ETL_D_IMG_87 
C. S_REGION 
D. S_ETL_I_IMG_87 
 
Answer: B 
 
Question: 19 
Which are true of Exception reports? Choose three. 
 
A. They are to be run prior to both full or refresh load 
B. Exception reports check the data integrity of the Siebel Relationship Management Warehouse 

database 
C. You can run them from the Data Warehouse Application Console client 
D. The ETL process might fail if the exceptions are not corrected 
 
Answer: A, C, D 
 
Question: 20 
When are change capture tables created? 
 
A. They are created when the DAC is pruned. 
B. They are created during the full and incremental loads to the data warehouse. 
C. They are created using a SQL script. 
D. They are created when SIF (Siebel Archive Files) are applied to the Siebel transactional 

database during installation. 
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Answer: D 
 
Question: 21 
Which of the following are some of the goals of data warehousing? Choose two. 
 
A. Integrate data from multiple sources 
B. Create more joins to save database space 
C. Simplify keys 
D. Normalize data 
 
Answer: A, C 
 
Question: 22 
In which of the following applications do you run Exception Reports? 
 
A. Informatica Monitor 
B. DAC client 
C. DAC server 
D. Siebel Tools 
E. Analytics Administration Tool 
 
Answer: B 
 
Question: 23 
Which of the following is true of the ETL process? 
 
A. SDE routines are used to extract data from the SRMW tables 
B. SDE routines are only for full extraction 
C. Staging tables have to be persistent until the next ETL processes 
D. SIL processes load data from the staging tables into the dimension and fact tables 
 
Answer: D 
 
Question: 24 
Which Siebel Relationship Management Warehouse table stores default values used in ETL? 
 
A. W_ETL_RUN_S 
B. W_PARAM_G 
C. W_ETL_DATASRC_S 
D. S_ETL_DATASRC 
 
Answer: B 
 
Question: 25 
Choose three. 
 
A. Analytics Web 
B. Web Catalog 
C. Informatica Server 
D. Siebel Repository 
E. DAC Server 
F. Analytics Repository 
 
Answer: A, B, F 
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Question: 26 
Which Siebel Relationship Management Warehouse component stores the data that the Siebel 
Analytics client accesses? 
 
A. Informatica Workflow Manager 
B. Informatica Repository Manager 
C. Administrator Workstation 
D. SRMW Database 
E. SRMW Server 
F. Repository Database 
 
Answer: D 
 
Question: 27 
Which is NOT true of the Siebel Analytics Standalone application? 
 
A. Provides a platform to model data in a form that users can easily understand 
B. Provides a server to generate SQL and seamless access to data from various sources 
C. Fully provides role-based dashboards to support the various roles in a company 
D. Provides an easy-to-use, highly interactive Web-based analysis tool to generate dynamic 

reports 
 
Answer: C 
 
Question: 28 
A business goal of your organization is to report revenue in a real-time manner. How should you 
configure the ETL to perform this function? 
 
A. Run an incremental ETL load run at regular intervals to refresh the entire SRMW. 
B. Populate all of the SRMW tables at a very high frequency (once every couple of hours) to 

ensure that the most up-to-date information is available. 
C. Run an incremental ETL load at regular intervals, but stop the load after the Revenue tables 

are populated. 
D. Populate a selected set of SRMW tables independent of the regularly scheduled incremental 

ETL load. 
 
Answer: D 
 
Question: 29 
In order to export all information contained in the Design view and the database connection 
information, what export category would you use? 
 
A. System 
B. Logical 
C. Design 
D. Run Time 
 
Answer: B 
 
Question: 30 
Exhibit: 
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Which of the following are true of the Exhibit? Choose two. 
 
A. This screen is made of two views 
B. The view maps to two business objects 
C. There are two list applets in this view 
D. The business component for this view is SME Exception 
E. You can get to this by selecting Help > About View in the application level menu 
 
Answer: D, E 
 
Question: 31 
You have imported WC_PROD_D source table in Informatica Designer and opened it in a Source 
Analyzer. How do you examine the table definition? Choose three. 
 
A. Double-click WC_PROD_D 
B. Right-click WC_PERSON_D and select Preview Data 
C. Right-click WC_PERSON_D and select Edit 
D. Select Sources > Edit from the Designer menu bar 
E. Select Edit > Tables from the Designer menu bar 
 
Answer: A, C, D 
 
Question: 32 
Which of the following DAC tasks can be used to populate the W_PARTY_LOGIN table? 
 
A. Aggregate 
B. Hierarchy 
C. Visibility 
D. Security 
 
Answer: C 
 
Question: 33 
ABC has several in-house Siebel Analytics consultants specializing in various roles. Which of the 
following duties would least likely to be performed by a data warehouse developer? 
 
A. Create logical models of the Data Warehouse database 
B. Generate physical models of the Data Warehouse database with the support of a database 

administrator 
C. Create reports and customize the Analytics UI 
D. Manage and maintain metadata repository 
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E. Create mappings and run ETL processes 
 
Answer: C 
 
Question: 34 
Which of the following Informatica Designer tools would you use to import, create, and maintain 
target definitions? 
 
A. Warehouse Designer 
B. Mapping Designer 
C. Source Analyzer 
D. Transformation Developer 
E. Mapplet Designer 
 
Answer: A 
 
Question: 35 
The standard (out of the box) ETL process populates the day dimension in what manner? 
 
A. After the day has passed so that all information about the date can be processed at once 
B. On the day when the date occurs 
C. In advance with 30 years worth of data about the date 
D. One week after the day has passed 
 
Answer: C 
 
Question: 36 
Which are the DAC views? Choose three. 
 
A. Design 
B. Execution Plans 
C. Schedule 
D. Setup 
E. Execute 
F. Run 
 
Answer: A, D, E 
 
Question: 37 
Which of the following are recommended ETL configuration practices? Choose three. 
 
A. Always run complete ETL process 
B. Test the modified ETL by running an execution plan 
C. Create a backup of the DAC repository 
D. Document all changes made to the repository 
 
Answer: B, C, D 
 
Question: 38 
SIL mappings contain additional components to those in an SDE mapping. Which are additional 
components used only in an SIL mapping? (Choose two) 
 
A. Filter transformation 
B. Update strategy transformation 
C. Expression transformation 
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D. Target definition 
 
Answer: A, B 
 
Question: 39 
Duties such as setting up database connections and designing data warehouse applications are 
typically performed by which of the following Siebel Analytics consultants? 
 
A. Server architect 
B. Data warehouse developer 
C. Application developer 
D. Siebel Tools configuration specialist 
 
Answer: B 
 
Question: 40 
Exhibit: 
 

 
 
Which of the following are true of the Exhibit? Choose two. 
 
 
A. It is used to find out the relationship between the business component, its field and the 

corresponding table and its columns 
B. It is the MVG applet of the Account List applet 
C. The Party name field of the Account business component maps to the ID column of the 

S_PARTY table 
D. The Id field of the Account business component maps to the ROW_ID column of the 

S_PARTY table 
 
Answer: A, D 
 
Question: 41 
In which internal table is the datasource identifier stored? 
 
A. W_DATASRC_NUM_G 
B. W_PARAM_G 
C. W_ETL_RUN_S 
D. W_LST_OF_VAL_G 
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E. S_ETL_RUN 
 
Answer: B 
 
Question: 42 
Which server provides the functionality of balancing loads across registered Informatica Servers? 
 
A. DAC Server 
B. Resonate 
C. Siebel Server 
D. Informatica Repository Server 
E. Siebel Analytics Server 
 
Answer: A 
 
Question: 43 
Which of the following are true of the Type R Change Capture tables? Choose two 
 
A. Type R Change Capture for S_ORG_EXT is S_ETL_D_IMG_26 
B. They maintain a record of all data extracted to the warehouse 
C. They store extracted data before loaded into target tables 
D. They store denormalized hierarchical relationships 
E. They store information about changes to data in transactional system 
 
Answer: B, E 
 
Question: 44 
Exhibit: 
 

 
 
 
What is the correct order of the steps in the exhibit required to build Slowly Changing 
Dimensions? 
 
A. D, E, A, C, B 
B. A, E, D, C, B 
C. E, D, C, A, B 
D. E, D, A, C, B 
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Answer: A 
 
Question: 45 
Which of the following do NOT have exception reports defined for them? Choose two. 
 
A. Aggregates 
B. List of Values 
C. Exchange rates 
D. Hierarchies 
E. Dimensions 
 
Answer: A, E 
 
Question: 46 
You want to see the sales figure by region by product. Which would be the fact in this 
dimensional model? 
 
A. Sales figure 
B. Product 
C. Product and Region 
D. Product, Region, and Time 
E. Sales figure and Product 
 
Answer: A 
 
Question: 47 
When do the Siebel Relationship Management Warehouse Hierarchy tables get populated? 
 
A. During the incremental image capture 
B. During the Extract 
C. During the Transform process 
D. During the Load process 
E. After loading the general, dimension and fact tables 
 
Answer: E 
 
Question: 48 
What are the benefits of selectively refreshing the data warehouse? 
 
A. It leaves a level of data latency between various data warehouse tables 
B. It saves time during the incremental ETL load because the selected tables are already 

populated 
C. It alleviates the need to run an incremental ETL load 
D. Impact on source systems is minimized 
 
Answer: D 
 
Question: 49 
Which Siebel Analytics component is used to launch jobs and make personalized results 
available to individual users? 
 
A. Siebel Relationship Management Warehouse 
B. Siebel Delivers 
C. Siebel Analytics Server and Siebel Analytics Web Server 
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D. Siebel Intelligence Dashboard 
E. Siebel Answers 
 
Answer: B 
 
Question: 50 
Which of the following are some of the reasons why incremental change capture is a better 
method than a traditional bulk load? Choose two. 
 
A. Data become more accurate as there are more data-cleansing efforts 
B. Incremental ETL runs are cheaper to run 
C. Change capture can occur while the operating system is still running 
D. There is a need to purge large amount of data from data warehouse 
 
Answer: B, C 
 
Question: 51 
Which of the following port types is used in Source objects in a mapping? 
 
A. Input 
B. Output 
C. Input/Output 
D. Variable 
 
Answer: B 
 
Question: 52 
Which of the statements are TRUE of Type I Slowly Changing Dimensions? Choose three. 
 
A. It updates the attribute. 
B. It does not insert new records. 
C. It contains the start and end dates during which the SCD attribute is in effect. 
D. It overwrites the existing attribute value with new information. 
E. It preserves the history of the changed attribute. 
 
Answer: A, B, D 
 
Question: 53 
Which statement is TRUE of deletes? 
 
A. Deletes are captured using delete triggers in the Siebel transactional database. 
B. The preconfigured Extraction, Transformation, Loading (ETL) process captures deletes for 

selected target tables in the Siebel transactional database. 
C. Deleted records are applied to the source tables in the SRMW. 
D. Records are physically deleted from the SRMW. 
 
Answer: A 
 
Question: 54 
Which of the following are true of the Selective Refresh ETL? Choose two. 
 
A. It refreshes different star schemas at different intervals 
B. It does not reduce ETL execution time 
C. There is a level of data latency between tables 
D. It loads the entire set of star schemas 
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Answer: A, C 
 
Question: 55 
A data warehouse developer added a column storing the preferred restaurant for a contact to the 
S_CONTACT table. And the W_CONTACT_D was modified to accommodate the new preferred 
restaurant column. Which type of customization was used? 
 
A. Type I 
B. Type II 
C. Type III 
D. Type IV 
 
Answer: A 
 
Question: 56 
Select the correct pair to complete this sentence: Staging tables are populated via ___ and the 
image tables are populated during _____. 
 
A. Hierarchy building; Transformation 
B. Extract; Hierarchy building 
C. Extract; Change Capture process 
D. Extract; Load 
E. Load; Full Image Capture 
F. Transform; Load 
 
Answer: C 
 
Question: 57 
Which of the following could be used to optimize ETL session performance? Choose two. 
 
A. Drop indexes prior to loading, and then recreate indexes afterwards 
B. Partition large fact tables 
C. Build mappings to maximize connection time to the OLTP 
D. Use constraint-based loading whenever possible 
 
Answer: A, B 
 
Question: 58 
Which Siebel Relationship Management Warehouse component accesses and processes the 
workflows in the Informatica repository? 
 
A. Data Warehouse Application Console (DAC) Client 
B. Informatica Repository 
C. Informatica Server 
D. DAC Repository 
 
Answer: C 
 
Question: 59 
Which of the items listed can function as change capture elements? Choose two. 
 
A. Mappings 
B. Repositories 
C. Tables 
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D. Views 
 
Answer: C, D 
 
Question: 60 
You need to add a new dimension table to a new fact table in the Siebel Relationship 
Management Warehouse database. Which of the following are the required columns in both the 
fact and dimension tables? 
 
A. ROW_WID, PROC_WID, INTEGRATION_ID, DATASOURCE_NUM_ID 
B. INTEGRAGION_ID, DATASOURCE_NUM_ID 
C. ETL_PROC_WID, INTEGRATION_ID, DATASOURCE_NUM_ID 
D. ROW_WID, ETL_PROC_WID, INTEGRATION_ID, DATASOURCE_NUM_ID 
 
Answer: D 
 
Question: 61 
Which of the following is used to process ETL workflows once the DAC initiates ETL tasks? 
 
A. DAC Server 
B. Informatica Server 
C. Informatica Repository Server 
D. Siebel Analytics Server 
E. Informatica Repository Manager 
 
Answer: B 
 
Question: 62 
Which of the following can you use to access the DAC Server to start and stop execution plans? 
Choose two. 
 
A. Third-party administration and management tools 
B. XML files 
C. DAC Client 
D. Command-line access 
 
Answer: C, D 
 
Question: 63 
Exhibit: 
 



Exam Name: Siebel 7.7 Analytics Data Warehouse Developer Professional Core Exam 
Exam Type Oracle    
Exam Code: 1Z0-640 Total Questions: 99 
 

Page 17 of 26   

 

 
 
Which of the following are true of the transformations used in the SDE_OrderDimension 
mapping? Choose three. 
 
A. Transformation that performs simple calculations 
B. Transformation that performs aggregate calculations 
C. A conditional filter 
D. Transformation that allows inserts, updates, deletes, and rejects 
E. Transformation that looks up values and passes to other objects 
F. Transformation that allows joins between tables in different data sources 
 
Answer: A, E, F 
 
Question: 64 
Exhibit:  
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Which are true of the research results? Choose two. 
 
A. The W_OPTY_D is the main table of the Opportunity Dimension Table Group 
B. The Opportunity Dimension Group is the only table group to which W_OPTY_D belongs 
C. This is a part of the DAC client Setup view 
D. The Opportunity Competitor Fact Group represents a star schema 
 
Answer: A, D 
 
Question: 65 
Which indexes are used to improve the performance of the ETL process? 
 
A. Query indexes 
B. ETL indexes 
C. Script indexes 
D. DAC indexes 
 
Answer: B 
 
Question: 66 
Which of the following are true of the Siebel Relationship Management Warehouse extension 
tables? Choose three. 
 
A. They are not maintained in Siebel Tools 
B. There is a one-to-one relationship between SRMW extension columns and the corresponding 

OLTP extension columns 
C. They have a one-to-one relationship with their corresponding dimension and fact tables 
D. For every extension table, there is an extension staging table 
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E. The standard mappings are used to populate any extension columns created 
F. ROW_WID is not needed on extension tables 
 
Answer: A, C, D 
 
Question: 67 
Which of the following Siebel Analytics components would you configure to automatically send an 
email to yourself when a service request is assigned to you? 
 
A. Siebel Delivers 
B. Siebel Answers 
C. Siebel Relationship Management Warehouse 
D. Disconnected Analytics 
E. Data Application Console (DAC) 
 
Answer: A 
 
Question: 68 
In which transformation object do you need to set a Lookup table name? 
 
A. Lookup Procedure 
B. Expression 
C. Update Strategy 
D. Filter 
 
Answer: A 
 
Question: 69 
After installing Informatica Client, Server, and DAC, why did you import a SIF file from the Siebel 
Tools\Objects folder in Siebel Tools? 
 
A. To create the OPB tables 
B. To create the Siebel OLTP seed data 
C. To create additional S_ETL_* tables that are necessary to run the ETL 
D. To create the warehouse tables 
 
Answer: C 
 
Question: 70 
You would like to add a column for an existing dimension table to a non-Siebel database data. 
What type of customization will you use? 
 
A. Type I 
B. Type II 
C. Type III 
D. Type IV 
 
Answer: C 
 
Question: 71 
Which Siebel Analytics component uses metadata to direct processing and connects natively or 
via ODBC to the database? 
 
A. Siebel Analytics Web Server 
B. Siebel Analytics Server 
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C. Siebel Analytics Scheduler 
D. Siebel Analytics Web Catalog 
E. Data Sources 
 
Answer: B 
 
Question: 72 
How many image tables are created for each source table in the Siebel transactional database? 
 
A. Five 
B. Three 
C. Two 
D. Four 
 
Answer: B 
 
Question: 73 
Which components are part of the Siebel Analytics (standalone) platform? Choose four. 
 
A. Web Catalog 
B. Analytics Web 
C. Analytics Repository 
D. Informatica Repository 
E. DAC Repository 
F. Siebel Analytics Server 
 
Answer: A, B, C, F 
 
Question: 74 
Which statements are TRUE of the auxiliary change capture process? Choose two. 
 
A. It considers primary table rows changed even if the record has not been updated in the primary 

table. 
B. It does not consider primary table rows changed if the record has not been updated in the 

primary table. 
C. Change capture occurs in primary, auxiliary, and source tables. 
D. The process forces the primary (header/master) table data to be extracted when data in 

auxiliary (child) table changes. 
 
Answer: A, D 
 
Question: 75 
Which of the following tables contains ROW_IDs of the records that have been identified as new 
or modified? 
 
A. S_ETL_I_IMG_45 
B. S_ETL_LOV 
C. S_ETL_PARAM 
D. S_ETL_RUN 
E. S_ETL_SRC_TABLE 
 
Answer: A 
 
Question: 76 
Refer to the Exhibit. 
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Order the steps required to selectively refresh the SRMW. 
 
A. B, E, C, A, D 
B. A, C, B, E, D 
C. E, A, B, C, D 
D. C, B, E, A, D 
 
Answer: D 
 
Question: 77 
In which of the DAC views would you define scheduling parameters to execute ETL plans? 
 
A. Design 
B. Monitor 
C. Execute 
D. Setup 
 
Answer: C 
 
Question: 78 
Which of the following columns is assigned the next sequential number and is used as a unique 
identifier for the warehouse? 
 
A. INTEGRATION_ID 
B. ROW_WID 
C. DATASOURCE_NUM_ID 
D. ETL_PROC_WID 
 
Answer: B 
 
Question: 79 
Which of the following are true of the Siebel Relationship Management Warehouse (SRMW)? 
Choose two. 
 
A. It includes a prebuilt database in a star schema format 
B. It can only be used with Siebel transactional database 
C. When using Siebel Analytics Server, third-party analytical tools cannot be used in conjunction 

with the SRMW 



Exam Name: Siebel 7.7 Analytics Data Warehouse Developer Professional Core Exam 
Exam Type Oracle    
Exam Code: 1Z0-640 Total Questions: 99 
 

Page 22 of 26   

 

D. It includes a set of tools that take the Siebel transactional data and other data and load them 
into the SRMW tables 

 
Answer: A, D 
 
Question: 80 
Which is NOT true of Workflow session log files? 
 
A. Generated for each session 
B. Saved in the Informatica Client directory 
C. Include allocation of system-shared memory 
D. Default name is session_name.log 
 
Answer: B 
 
Question: 81 
ETL Parameters are configured using which of the following? Choose two. 
 
A. JavaScript 
B. Informatica Parameter Files 
C. DAC Client 
D. DAC Command Line 
 
Answer: B, C 
 
Question: 82 
Your initial ETL process failed. Which of the following logs would you check to fix the problems? 
Choose two. 
 
A. Informatica Client session log 
B. Informatica Server session log 
C. DAC Server log 
D. NQServer log 
 
Answer: B, C 
 
Question: 83 
Which of the following ensures a single enterprise view across the Siebel Relationship 
Management Warehouse and also enables a cross-fact analysis? 
 
A. Change capture tables 
B. Star schema 
C. Conforming dimensions 
D. Snowflake schema 
E. Prune days ETL preference 
 
Answer: C 
 
Question: 84 
Which of the following are true of the Data Application Console (DAC)? Choose three. 
 
A. It helps minimize installation, setup, and configuration time 
B. It facilitates quick data warehouse application development 
C. It is optimized for small data warehouses with little to no customization 
D. It helps minimize ETL execution time 
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E. It comes standard with any Siebel Analytics purchase 
 
Answer: A, B, D 
 
Question: 85 
Which of the following has the appropriate permissions for the Siebel transaction database and 
the SRMW database if the Siebel transaction database is on MS SQL Server platform? 
 
A. SSE_ROLE 
B. Hostname 
C. NT Login ID 
D. SADMIN 
 
Answer: A 
 
Question: 86 
Which of the following are true of the DAC objects? Choose two. 
 
A. A table group is a logical grouping of tables that defines a logical relationship between its 

component tables 
B. The DAC repository objects have a hierarchical relationship to each other 
C. Subject areas in the DAC always coincide with the Answers subject areas 
D. The tables cannot be transactional tables 
 
Answer: A, B 
 
Question: 87 
Which of the following would you use to reduce ETL processing to improve performance? Choose 
two. 
 
A. Identify DAC objects associated with required tables and prune those that are not related to 

the star schemas used in your business 
B. Use complete ETL 
C. Always use Selective Refresh ETL 
D. Delete unnecessary table groups in subject areas in DAC 
E. Create indexes on relevant image tables 
 
Answer: A, E 
 
Question: 88 
Which of the following are true of the Data Warehouse Application Console (DAC)? Choose 
three. 
 
A. It provides access to the entire SRMW application to configure and execute ETL 
B. It is a third-party tool of the SRMW components 
C. It is a command-line utility to run ETL or Exception Reports 
D. You can register Informatica Servers and source and target databases 
E. You can restart the ETL from the point of failure 
 
Answer: A, D, E 
 
Question: 89 
What is the suggested first step to create an SDE mapping? 
 
A. Create an expression transformation and target definition. 
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B. Create a Source Qualifier. 
C. Create a source definition. 
D. Leverage an existing mapping by copying it to the custom folder for reuse. 
 
Answer: D 
 
Question: 90 
Which tool would you use to execute mappings? Choose two. 
 
A. Informatica Workflow Manager 
B. Informatica Repository Manager 
C. DAC Client 
D. Informatica Repository Server 
 
Answer: A, C 
 
Question: 91 
Which of the following is used by mappings to move data from sources to targets? 
 
A. Workflow monitor 
B. Session 
C. Port 
D. Mapplet 
 
Answer: B 
 
Question: 92 
Which relationship management warehouse table sums service request data by measures 
including Minutes Open, Total SRs, Open SRs, Closed SRs, Pending SRs by Severity, Status, 
Product and Owner? 
 
A. W_SRVREQ_A 
B. W_SRVREQ_D 
C. W_SRVREQ_DX 
D. W_SRVREQ_FS 
E. W_SRVREQ_MD 
 
Answer: A 
 
Question: 93 
What type of index has reduced storage requirements when compared to that of other indexing 
techniques? 
 
A. B-Tree index 
B. JPEG index 
C. Bitmap index 
D. Clustered index 
 
Answer: C 
 
Question: 94 
Which of the following transformation types is used to perform simple calculations on a row-by-
row basis? 
 
A. Aggregator transformation 
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B. Filter transformation 
C. Normalizer transformation 
D. Expression transformation 
 
Answer: D 
 
Question: 95 
Which is true of the WC_PERSON_DSX? 
 
A. It is a standard extension table where data is initially loaded in SRMW after running the SDE 

session 
B. It is a custom extension table where data is loaded in SRMW after running the SIL session 
C. It is a custom extension table where data is initially loaded in SRMW after running the SDE 

session 
D. It is a custom staging extension table 
 
Answer: D 
 
Question: 96 
Exhibit: 
 

 
 
Which table's properties are depicted here? 
 
A. Type R Change Capture table 
B. Type I Change Capture table 
C. Internal table 
D. Hierarchy table 
 
Answer: A 
 
Question: 97 
Which of the following DAC objects is used to define whether a task has prerequisite tasks that 
need to be executed prior to its own execution? 
 
A. Execution plan 
B. Subject Area 
C. Table Group 
D. Dependency 
 
Answer: D 
 
Question: 98 
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In order to export all information contained in the Execute view, what export category would you 
use? 
 
A. Execute 
B. Logical 
C. Run Time 
D. System 
 
Answer: C 
 
Question: 99 
In your implementation, the standard extension tables do not meet the requirements and 
therefore new staging tables need to be created. Which of the following is true of the new 
extension tables? 
 
A. They are extended the Siebel Relationship Management Warehouse tables 
B. They have the W_ prefix 
C. The ROW_ID, INTEGRATION_ID, DATASOURCE_NUM_ID columns of the new tables 

cannot be null 
D. The INTEGRATION_ID and DATASOURCE_NUM_ID columns are required for the staging 

tables 
 
Answer: D 
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